OMB Number: 0915-0146
Expiration Date: xx/XX/Xxxx

Bureau of Health Workforce
NHHSP Applicant Information Screen User Guide

Health Resources & Services Administration
(HRSA)

BHW Management Information System Solution (BMISS)

Native Hawaiian Health Scholarship Program (NHHSP)
Applicant Information Screen User Guide

March 2019

Public Burden Statement: The purpose of this information collection is to obtain information through the Native Hawaiian
Health Scholarship Program, which is used to assess an applicant’s eligibility and qualifications for the NHHSP. Clinicians
interested in participating in the NHHSP must submit an application to the NHHSP, which is administered by Papa Ola
Lokahi. An agency may not conduct or sponsor, and a person is not required to respond to, a collection of information
unless it displays a currently valid OMB control number. The OMB control number for this information collection is
0915-0146 and it is valid until xx/xx/xxxx. This information collection is required to obtain or retain a benefit (The Native
Hawaiian Health Care Improvement Act of 1992, as amended [42 U.S.C. 11709]). The information is protected by the
Privacy Act, but it may be disclosed outside the U.S. Department of Health and Human Services, as permitted by the Privacy
Act and Freedom of Information Act, to Congress, the National Archives, and the Government Accountability Office, and
pursuant to court order and various routine uses as described in the System of Record Notice 09-15-0037. Public reporting
burden for this collection of information is estimated to average xx hour per response, including the time for reviewing
instructions, searching existing data sources, and completing and reviewing the collection of information. Send comments
regarding this burden estimate or any other aspect of this collection of information, including suggestions for reducing this
burden, to HRSA Reports Clearance Officer, 5600 Fishers Lane, Room 14NWHO04, Rockville, Maryland, 20857.

. SERVICEg
P (3

ol )
2
i
: C
g
\-
q‘f%h . A
Wvaaq Health Resources & Services Administration
1

Property of HRSA | BHW



Bureau of
NHHSP Ap

Health Workforce
plicant Information Screen User Guide

Table of Contents

Section 1:
Section 2:
Section 3:
Section 4:
Section 5:
Section 6:
Section 7:
Section 8:

Section 9:

Section 10:
Section 11:
Section 12:
Section 13:
Section 14:
Section 15:
Section 16:
Section 17:
Section 18:
Section 19:
Section 20:
Section 21:
Section 22:

Section 23:

Introduction: NHHSP Applicant Information Screen User GUIde........cuueiieiiiiieeiiieee e eseee e sseeee e 4
NHHSP Applicant to Participant Process FIOW .......c.ceiiiiiiiiiiiiiii et 5
NHHSP Data Collection WOrkSheet........cociieeiiiiieiieeieeeeeeee e 6
Secure File Transfer of Applicant Data from POLto HRSA.........cccoiiiiiiii e, 10
Standard File Naming CONVENTION ....cccvviiiiiiiie ettt ettt e et e e atae e e e eaba e e e eareeas 12
Applicant Data - CSV File FIeldS.......uiiiiiiiiiieiie ettt e s s ebae e e 13
Applicant Data - CSV File FOrMAt ....ccoiciiiiiiiie ettt e e ree e e s e e e areeas 15
Applicant Data - NHHSP Disciplings & DEEIEES.......ccivcvieieiiiiieieciiee e eeitee e eereee e eeveee s svee e e esaveeas 16
Applicant Data Transfer in BIVIISS .........uviii ettt e et e e etae e e e ebae e e 17
Applicant Data Transfer — Validation FIags ........cccuerieiiiiii i e 21

Applicant Data Transfer — ContinUatioNnS.........coovciiiiiiiiie e 26
Task DAShDOAIM ....c...eiiiiiiiiieie ettt ettt et e e sbe e e sabe e sbeeebeeesabeeeanas 28
New NHHSP Award - Upload Supporting DOCUMENTS........cccccuieeiiiiieeeeiieeeecireeeesieeeessvaee e 29
New NHHSP Award - Personal Information ........c..ccoueeieiiiinienienieceeeeeeeeeee e 31
New NHHSP Award - School INformation ..ot 32
New NHHSP Award - Financial Information .......c..ccoueeiiiiniiineeeeeeceee e 35
New NHHSP Award - Award INnformation.......cccccooeerierieiieenieneesercee e 36
New NHHSP AWard - PrevieW PAW .. ....ooii ittt ettt ettt et sate e s 38
New NHHSP Award - Save and ClOSE .......c.coveerieerierienie et 40
New NHHSP Award - Cancel AWard TasK .......coeceeeiieeiiieeiee et 41
New NHHSP Award - Submit Applicant Data .......ccccvviieeeii e 42
New NHHSP Award - Manual Input of Applicant Data.......c.cccccueeeeiiieeeeiiieee e 44
NHHSP Participant Profile and Obligation ..........coccuveiiiiiiie i 45
RESOIVING ISSUBS.....uetiiieieitiie et ee ettt e ettt e e et e e et te e e e eat e e e e eataeeeestaeeeessaeeeessaeeesnnsaeeesnnsaneeans 47
2

Property of HRSA | BHW



Bureau of Health Workforce
NHHSP Applicant Information Screen User Guide

Document Version History

Version | Implemented Revision Reason
# By Date
1.0 Asad Sagib 3-21-19 Created new version of NHHSP user guide with reference
to previous version created in June 2012
1.1 Asad Sagib 3-26-19 Minor language updates
1.2 Chris Hester 3-27-19 Minor language updates
3

Property of HRSA | BHW



Bureau of Health Workforce
NHHSP Applicant Information Screen User Guide

Introduction: NHHSP Applicant Information Screen User Guide

Overview: NHHSP is a merit based scholarship program that recruits participants focused within primary
care health disciplines and dedicated to providing primary health services to Native Hawaiians and their
families in Hawaii. The NHHSP is administered by the BHW program NURSE Corps and is also currently
administered in conjunction with the Grantee, Papa Ola Lokahi (POL), which is located in Hawaii. The
NHHSP is currently managed within the BHW Management Information System Solution (BMISS)
platform.

Goal: The goal of the NHHSP Applicant Information Screen User Guide is to provide guidance on
entering NHHSP applicant information into BMISS.

Roles: NHHSP Analysts
Preconditions:

e Applicant has applied to the NHHSP
e Applicant is deemed eligible

Post-conditions:

e Applicant information has been saved in BMISS
e Applicant is converted to Participant

4
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Section 1: NHHSP Applicant to Participant Process Flow

Overview: The high level process flow for NHHSP applicant selection and is below:

NHHSP - Participant Selection Process

POL HRSA / BHW

POLReviews
Applciations and
Makes Selections

Final Selections for

Awards are Made/
POLSends COI to

potential Awardees

POL Conducts
Orientations -
Potential Awardees
Sign Contracts

Other additional required
paperwork may be completed
atthis time as needed.

POL sends application pdf and paPi:;:a;erng:d DHCES reviews and CSV fileis downloaded from SEFT
CsVfilesto HRSA-NHHSP documents and CSV _mputsa\_/varq and uploaded to BMISS along with
Analysts electronically through information in uploaded pdf application

data and sends to
SEFT BHW BMISS documents

HRSA solicits DCW Collected DCW information is
Information from used to determine the availability
Selected Schools of funds for awards

NHHSP Application / DCW / Participant Selection

Awardees are
approved and
converted to
participants and
obligations in BMISS

HRSA countersigns

awardee contracts

and sends to POL
through SEFT

POL performs
NHHSP participant = s

monitoring activites
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Section 2: NHHSP Data Collection Worksheet

Overview: Users assigned School POCs roles within the BMISS Extranet can create and submit NHHSP
Data Collection Worksheet (DCW) data for school Tuition, Fees, and Other Reasonable Costs (ORC) for
their respective schools during the annual DCW open cycle. NURSE Corps personnel will alert school
POC’s when the DCW period is open, underway, and closed. They will also notify the Grantee, (POL)
about the statuses of the DCWs for awareness and POC outreach if needed.

Users assigned School Analyst roles within BMISS Extranet can create, edit, and approve previously
submitted DCWs.

Business Rules: User must have a School Analyst role within the BMISS Extranet School Representative
portal.

Steps:

1. School Analyst navigates to the BMISS Extranet > School Representative Portal and logs in with
their School Analyst credentials via the link:
https://programportal.hrsa.gov/extranet/landing.seam

Welcome to
the BHW

porr.:ﬂ

AN APPLICANT

Applying for the NHSC Loan Repayment Program »
Applying for the NHSC Scholarship Program »

Applying for the Murse Corps Scholarship Program »
Applying for the MURSE Corps Loan Repayment Program »
Applying for the Faculty Loan Repayment Program »

Applying for the Students to Service Loan Repayment Program »
A PARTICIPANT
Ina Loan Repayment or Scholarship Program »

A SITE POINT OF CONTACT, REPRESENTATIVE OR PCO

A Site Administrator »

A State Primary Care Office Member »
I A School Representative » I

INTERESTED IN LEARNING MORE

About BHW »

Figure 1: DCW School Representative Link
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2. Search for any NHHSP DCW by searching for the NHHSP Program and any other criteria such as
School Name

The DCW Search for Analysts

School Name

wirginia
State or Terrtory Select v
Has Current Applicants | Select ¥

Frogram MHHSF ¥
Discipline lselem v
Degres Select ¥
Siatusz Select v
Search

Figure 2: DCW Search for Analysts

3. To create a DCW simply click on the Create link under the Action column for any DCW

The DCW Search for Analysts

School Mame

State or Termtorny

Has Current Applicants
Program

Discipline

Degres

Status

Search

Search Results

wirginia

Select v
Select ¥

MHHSP ¥

Select v
Select ¥

Select v

SEARCH RESULTS

Eastern Virginia Medical School \irginia MNHHEP  Allopathic MD 201e Mot reate
Physician -2020 Startad

Eastern Vinginia Medical Schood irginia NHHSP  Physician Master's 2018 Mot Create
Aszistant -2020 Started

ECPI University, \irginia Beach \irginia MNHHEF  Mursa Master's pron =] Mot Create
Practitioner -2020 Started

ECPI1 University, \irginia Beach \firginia MNHHEP Registered Murse Bachelor's 20a Mot Create

-2020 Started

Edward Via Yirginia College of Osteopsthic  Wirginia MNHHEF  Osteopathic [nle] 2018 Mot Create

Medizing Physician -2020 Stared

George Washington University Wirginia \firginia MNHHSF  Murse Master's 218 Approved  View'Edit

Campus Practitioner -2020

George Washington University Wirginia \irginia MHHEFP  Murse Dwoctor of Mursing Practice 2019 Mot Create

Campus Practitioner (DMNP} -2020 Started

Figure 3: Create DCW Link
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4. When adding the financial data for a NHHSP DCW please note that Resident and Non-Resident

fields for all four years are required fields. Also, please note that the ‘S’ symbol must be included
in the financial data fields.

fer SCHOOL REPRESENTATIVES Home Log Out

Data Collection Worksheet Form

= vequived fleld

School Discipline Degres
George Washington University Virginia Campus Registered Nurse Bachelor's

Thank you for creating 3 DCW! The form can be completed in 3 easy steps. Please note that all information must be filled in properly to avoid any
processing errors, which could result in delsyed andior incormect payments, which may sdversely affect the student.

1. ANNUAL TUITION (2019-2020)

Enter the Resident (In-State) and Mon-resident [Qut-of-State) tuition for the entire ACADEMIC year for 1st, 2nd. 3rd, and 4ih “esr Students. If your school's
degres program is less than 4 years, only enter amounts for each yesr of your program. For example, two year programs would only enter values in the first
two columns for 15t and 2nd Year Students. You MUST enter velues for every year of your program, ewven if your costs are estimated to be the same for
students regsrdless of which year they are in the program. |f your institution uses @ semester system; please include the tuition smount to be enrolled in as
= full-time student for each semester (summer, fll, and spring semesters (2 semasters)). If your instifution uses s quarter system; plesse include the tuition

1st Year Student 2red Year Student 3rd Year Student 4th Year Student
Resident * 51000 51000 51000 51000

Mon-Resident = 32000 32000 32000 52000

2. FEES

Review and entar amounts for the list of items grouped under Fess for the entire ACADEMIC year. The fes fypes listed are the only eligible fees for the
MHHSP The MHHSF would expect items defined s= Fees 1o be included in the tuition invoice submitted by the school and reimbursed by MHHSP directly to
the school. Insurance items may be incurred by the school 25 part of the tuifion and required fees or incurred ss an ORC by the Student. Plesss complata
the form based on if the cost of insurance is incurred by the school or incurred by the student.

1st Year Student 2nd Year Student 3rd Year Student 4th Year Student
Acsdemic Support Services 30 30 30 30
Administrative Feas 30 30 30 30
Background Check 30 30 30 30
Campus Life Fae 30 30 50 30
Capstone Course (if 30 30 50 30

Figure 4: DCW Form
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5. To submit the DCW enter a required comment and click on the Save button. This will update the
DCW to a ‘Submitted’ status (not Approved). You can then search for the DCW again and it will
display a ‘View/Edit’ link under the Action column. In order to approve the DCW click on the
check box ‘I approve the Data Colllection Worksheet’ either during the initial input of data or
return back to the ‘Submitted’ DCW by clicking on the ‘View/Edit’ link and select the checkbox

and save the DCW.

Microscope (Rental or 30 50 80 30
Furchase)
Mational Boards (Parts | & SO S0 50 S0
; CS & CK: medical &
dentsl students only)
Schoal ID Cards/ID Fees (if 30 50 50 30
not billed as part of tuiton
and fees)
Travel for Clinical Training 30 50 80 30
(not include locsl
commuting expense)
Education Materisls Cost 30 30 30 30
Unifiorms. (limit to 2 seis) s0 50 S0 30
and Mame Tags
Other Fees 30 0 S0 30
\ Please explain any "other” fees in the comments section below.
approve this Data Collecton Workshest
Existing Comments
There are no existing comments.
New Comments
P
CANCEL SAVE
Figure 5: Submit and Approve DCW
Edward Via \firginia College of Ostecpathic Wirginia MHHEF  Osteopathic oo 20148 Mot Create
Medicing Physician -2020 Startad
George Washington University \Wirginia ‘irginia MHHSF  MNurse Master's 2018 iewlEdit
Campus Practitioner -2020
George Washington University Virginia \firginia MHHEP  Murse Doctor of Mursing Practice 2018 Mot Create
Campus Practitioner (DMIP) -2020 Stared
George Washington University Wirginia \firginis MHHEP Registered Muse Bachelors 2010 iewlEdit
Campus -2020
Morthern Wirginia Community College ‘irginia MHHEF  Registered Murse  Associale's 2018 Mot Create
-2020 Startad

Figure 6: DCW Status: Approved vs Submitted
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Section 3: Secure File Transfer of Applicant Data from POL to HRSA

Overview: The Grantee, (POL) will provide HRSA with NHHSP application data through SFTP of various
files. These files will include a scanned pdf of application documents for each individual applicant, as
well as a CSV file of the applicant data that needs to be uploaded to BMISS.

Business Rules: User must have an account with SEFT and access to the specific NHHSP folder space in
order to upload and/or download files.

Steps:

1. User navigate and log in to SEFT at the following link: https://secureemail.nih.gov/bds/Login.do

m) National Institutes of Health
Turning Discovery Into Health

Secure Email and File Transfer Service

This service allows NIH users and its customers to send email securely and
confidentially over an SSLY encrypted connection, with or without large
documents.

&ll NIH users are PRE-registered to RECEIVE deliveries via this service.

To SEND a delivery using this service, please request permission by contacting
MIH Help Desk:

- Online: Click here to submit a request using web form.

- Phone: 301-496-4357 (6-HELP) (local)
866-319-4357 (toll free)
301-496-8294 (TTY)

If you are already registered, please enter your username and password to sign
in:

- MIH and HRSA Users: Sign in with your domain account using
DomaintUsername (e.g. NIHYDoej or HRSA\Doej)

- Non-NIH-HRSA Users: Sign in with your registered email address (e.g.
Doel@yahoo.com)
Username Forgot your password?

- Non-NIH Users; please go
to ForgotPassword

Password - NIH Users: please go to
IForgotMyPassword.nih.gov

Question?

- - please visit Freguently Asked
=0T Questions (FAQs)

Figure 7: SEFT Sign In Page
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2. The folder structure within the NHHSP SEFT space is the following:
>Cohort (e.g., POL 2019 Cohort Packages)
>Application Docs

>CSV
>Signed Contract

m National Institutes of Health
Turning Discovery Inta Health

0 tobox Workspace: NHHSP
- Workspaces i=

Up | Mew Folder Detzilz = Folders
Jh Reports - b [ Workspace POL 2013 Cohort Packages

5 [ Cobort
9 Help o ) Testing q r] q

appization c=v Signed Cant

@ I-JE_C‘B ds o Docs ract

WView fibe list

Figure 8: SEFT Folder Structure

3. The Grantee, (POL) will upload the scanned PDF applications to the ‘Applicant Docs’ folder, and
will upload the applicant CSV data file to the ‘CSV’ folder. The NHHSP Analyst will be able to
navigate to these folders to download these respective files to their H:\ drives in order to upload
them into BMISS.

4. The NHHSP Analyst will later upload a countersigned applicant contract to the ‘Signed Contract’
folder in order for the Grantee, (POL) to download.

5. SEFT will notify users with access when a folder is updated with new files; however, the analyst
can also directly notify POL when the countersigned contracts have been uploaded to the Signed
Contract folder so POL can download as needed.

11
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Section 4: Standard File Naming Convention

Overview: A standard file naming convention has been provided in the table below for various
documents and files that are required during the processing of NHHSP applicants within BMISS. Please
following the guidelines below to ensure accurate and consistent formatting and version control for all
applicant documents.

Document Type Standard Format Example
CcsVv NHHSP_Cohort_Applicant_Data_vX.csv NHHSP_2019 Applicant_Data_v1.csv
Application PDF NHHSP_Cohort_Application_LastName_FirstName_vX.pdf NHHSP_2019_Application_Smith_John_v1.pdf
Award Letter NHHSP_Cohort_Award_Letter_LastName_FirstName_vX.pdf NHHSP_2019_Award_Letter_Smith_John_v1.pdf
w4 NHHSP_Cohort_W4_LastName_FirstName_vX.pdf NHHSP_2019_W4_Smith_John_v1.pdf
Contract NHHSP_Cohort_Contract_LastName_FirstName_vX.pdf NHHSP_2019_Contract_Smith_John_v1.pdf
Countersigned NHHSP_Cohort_CounterSigned_Contract_LastName_FirstName | NHHSP_2019_CounterSigned_Contract_Smith_John_v1.pdf
Contract _vX.pdf
12
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Section 5: Applicant Data - CSV File Fields

Overview: The Grantee, (POL) will send a NHHSP CSV file with applicant data that will be uploaded to
BMISS and used to auto-populate data fields within the New NHHSP Award page. The CSV file can
include data for one or more applicants and the data will be exported from the POL source system
(currently FileMaker Pro). Below is a table that lists the specific CSV BMISS data fields expected to be
included in the file and characteristics of each.

Business Rules: The current BMISS values are intended to be used in any fields in the table below that
include the note “Provided POL BMISS Values”. If/when there are any updates in BMISS to those fields
they will need to be provided to POL to update their source system for the CSV data export. If those
values aren’t updated prior to the CSV file being populated/downloaded, BMISS will not include those
fields in the import process. BMISS will process default blank values in those fields that can be later
edited, either manually or via a file updated by either POL or the analyst during the CSV upload process.

CSV BMISS Field
Personal Information

BMISS Required

Field Type / Notes

Data Type / Limits

Full Name
First Name Y String / 100 characters Text box
Last Name Y String / 100 characters Text box
Middle Initial N String / 1 character Text box (1 character limit)
Title N String / 4 characters Dropdown (Mr., Mrs., Ms., Dr.)
Provided POL BMISS values
Suffix N String / 5 characters Dropdown
Provided POL BMISS values
SSN Y Number / 9 digits Text box
D.O.B. Y String / 10 characters Date picker (MM/DD/YYYY)
Home Address
Home Street Address 1 Y String/ 250 characters Text box
Home Street Address 2 N String/ 250 characters Text box
Home City Y String/ 100 characters Text box
Home State or Territory Y String/ 2 characters Dropdown
Provided POL BMISS values
Home Zip Code Y String/ 20 characters Text box
Home Country Y String/ 50 characters Dropdown
Prepopulated with 'United
States'
Provided POL BMISS values
Mailing Address
Mailing Street Address 1 Y String/ 250 characters Text box
Mailing Street Address 2 N String/ 250 characters Text box
Mailing City Y String/ 100 characters Text box

13
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Mailing State

Mailing Zip Code
Mailing Country

Phone and Email
Daytime Non-US
Number
Daytime
Ext
Home Non-US Number
Home
Mobile Non-US Number
Mobile
Personal (Email)
Work (Email)

School Information
Cohort
Year In School
Graduation Date
Funding Start Date
Funding End Date

School Details
University Name

University Address 1
University Address 2
University City
University State
University Zip
Degree

Discipline

Continuation Yrs Req

In State / Out of State

Y

=2

2222222 <

< </</< /=<

String/ 2 characters

String/ 20 characters
String/ 50 characters

bit/0Oor1

String / 50 characters
String / 10 characters

bit/0or1

String / 50 characters

bit/0or1

String / 50 characters
String / 250 characters
String / 250 characters

Number/ 9999

String/1lor2or3or4
String / 10 characters
String / 10 characters
String / 10 characters

String / 250 characters
String/ 250 characters
String/ 250 characters

String/ 100 characters

String/ 2 characters

String/ 20 characters
String / 250 characters

String / 250 characters

Number

Number/ NULL(blank),

1,23

Number/0Oor 1

14
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Dropdown

Provided POL BMISS values
Text box

Dropdown

Provided POL BMISS values

Checkbox

Text box
Text box
Checkbox
Text box
Checkbox
Text box
Text box
Text box

Read only text

Dropdown (1, 2, 3, 4)

Date picker (MM/DD/YYYY)
Date picker (MM/DD/YYYY)
Date picker (MM/DD/YYYY)

Read Only Text

Provided POL BMISS values
Read Only Text

Provided POL BMISS values
Read Only Text

Provided POL BMISS values
Read Only Text

Provided POL BMISS values
Read Only Text

Provided POL BMISS values
Read Only Text

Provided POL BMISS values
Dropdown

Provided POL BMISS values
Dropdown

Provided POL BMISS values

Dropdown

Will only be used as a validation

from the CSV and will

not be displayed in BMISS
In State=1

Out of State =0
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Section 6: Applicant Data - CSV File Format

Overview: The NHHSP CSV file provided by the Grantee, (POL) will be required to have a very specific file
format and order of fields in order to auto-populate the data in the New NHHSP Award page. Below is
the CSV file format and order expected.

Business Rules:

e The CSV file must only include applicant data for the upcoming cohort.

e The CSV file must following the specific format of fields and the order of fields listed below.

e Required fields must be included in the CSV.

e Blank values are permitted for non-required fields, however comma separated values are still
required for all fields.

e The CSV file can contain one or more rows of applicant data, however each applicant requires a
unique row.

e leading zeros must be included in the CSV file for all fields such as Date, ZIP, and SSN (e.g.,
01/01/2020 vs 1/1/2010).

Expected NHHSP CSV File Format:

First Name, Last Name, Middle Name, Title, Suffix, SSN, DOB, Home Street Address 1, Home Street
Address 2, Home City, Home State, Home Zip, Home Country, Mailing Street Address 1, Mailing Street
Address 2, Mailing City, Mailing State, Mailing Zip, Mailing Country, Daytime Non-US Number, Daytime
Phone, Ext, Home Non-US Number, Home Phone, Mobile Non-US Number, Mobile Phone, Personal
Email, Work Email, Cohort, Year in School, Graduation Date, Funding Start Date, Funding End Date,
University Name, University Address 1, University Address 2, University City, University State, University
Zip, Degree, Discipline, Rank, Continuations Yrs Req, In State / Out of State

Sample CSV Data for a Single NHHSP Applicant:

"John","Smith","H","Mr.","Sr.","031987893","01/15/1985","771 Lucky Dr","Suite
2","Centreville","VA","22052","United States","888 Happy Dr","Suite
1","Springfield","VA","20120","United
States","1","7039125852","444","0","5713457777","0","3017894114","personal@email.com","work@e
mail.com","2019","2","05/24/2022","07/01/2019","06/30/2020","University of Virginia", "388 Memory
Ln","Suite 200","Charlottesville","VA","22802","MD","Allopathic Physician","1","1","0"

15
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Section 7: Applicant Data - NHHSP Disciplines & Degrees

Overview: The NHHSP program currently has a specific list of disciplines and corresponding degrees that
are accepted and can be used when submitting applicant data to BMISS. Below is a list of the NHHSP

discipline and degree combinations:

BMISS NHHSP Disciplines
Allopathic Physician
Clinical Psychology
Clinical Psychology
Dental Hygiene
Dental Hygiene
Dentist

Dentist
Dietetics/Nutrition
Marriage and Family Therapist
Nurse Mid-Wife
Nurse Practitioner
Nurse Practitioner
Optometry
Osteopathic Physician
Pharmacy

Physician Assistant
Physician Assistant
Public Health

Public Health
Registered Nurse
Registered Nurse
Registered Nurse
Social Work

BMISS NHHSP Degree

MD

Doctorate (non-MD or Ph.D)
Ph.D

Bachelor's

Associate's

DMD

DDS

Master's

Master's

Master's

Master's

Doctor of Nursing Practice (DNP)
Doctorate (non-MD or Ph.D)
DO

Doctorate (non-MD or Ph.D)
Master's

Doctorate (non-MD or Ph.D)
Master's

Doctorate (non-MD or Ph.D)
Associate's

Bachelor's

Master's

Master's

16
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Section 8: Applicant Data Transfer in BMISS

Overview: The NHHSP Analyst can upload the applicant CSV file for initial review in BMISS through the
NHHSP Applicant Data Transfer page within BMISS Intranet.

Please note that this initial process of CSV data upload will only result in creating Tasks within Task
Manager and does not create the official NHHSP participant profile and corresponding financial
obligations in BMISS. Further steps are needed within the submission of the New NHHSP Award in order
to create the NHHSP participant profile and financial obligations.

Business Rules: Analyst must have BMISS Intranet access and a NHHSP Reviewer role
Steps:

1. NHHSP Analyst navigates to the NHHSP Application Data Transfer page in the following location
within BMISS Intranet: Programs > NHHSP > Applicant Data Transfer

@HRSA Health Resources & Services Administration 1
BM I S S Welcome hrsa\asagib | Close

Person Search Participant Sites 8 Schools User Administration Reports.

Super Admin Ambassador FLRP
NCLRP
BHW Management Information ycre.ne

NHHSP Batch History

Welcome to BMISS! NHSC LRP

Budget News and Announcements
BMISS is the way we conduct business with our p Gt Create Batch for all AET T T T ST p—
BHW employees and it will only improve and adve Ncsp ide your LT (7 LA 2 ’ UL
New Award deployed to the BMISS platform. The FY19 NCLRP

feedback on BMISS to your BMISS Expert or yout - S
S25 LRP Create Tuition Payment New Award Application was relaunched and

To ensure BMISS works for everyone, remember issesseememmmpem——m included telehealth questions and the new
application t}-pe..NP.-Psych. f.\dd?tmr?:c]lly. the FY19
«+ Be clear and complete in your summaries and comments. You mz icipant | NHSC LRP Mew Award Application was relaunched
i £ 7 v and included enhancements to support the NHSC

hat contacted BHVW previousiv You knowr what level of defail vou need fo do tha

Figure 9: Applicant Data Transfer Navigation

2. A manual CSV upload feature is available in which the analyst can select a file from their local
machine or network to upload awardee data to the page for review. A data table with the
following columns headers, that are a subset of the data from the CSV, will populate the
associated data in the table with the CSV uploaded data:

e Checkbox (Select All and select individual rows)
e Rank

e First Name

e Last Name

e Degree
e Discipline
e Flagged

17
Property of HRSA | BHW



Bureau of Health Workforce
NHHSP Applicant Information Screen User Guide

@HRSA Health Resources & Services Administration

BM I S S ‘Welcome hrsalasagib | Close
Person Search Participant Programs Sites & Schools User Administration Reports
Super Admin Ambassador
NHHSP Applicant Data Transfer
Fleaze note: The following file type(s) are suitable for upload: csv
Choose File | Mo file chosen Upload
| | Rank First Name Last Name Degree Discipline Flagged

Figure 10: NHHSP Applicant Data Transfer Page

3. After the CSV file is uploaded a successful banner message will be displayed. The analyst will
then be able to review the rows of data which each correspond to a single NHHSP applicant
within the CSV file. The analyst will be able to select the specific row(s) of data to submit to
create a Task within Task Dashboard.

NHHSP Applicant Data Transfer
‘ (_) File name: good-data.csv successfully loaded.
Flease note: The following file type(s) are suitable for upload: csv
Choose File | No file chosen Upload
| | Rank First Name Last Name Degree Discipline Flagged
Ld 1 John Smith MD Allopathic Physician
Ld 2 Jane Doe MD Allopathic Physician
3 Larry Warner MD Allopathic Physician
4 David James MD Allopathic Physician
5 Hakeem Qlajuwon MD Allopathic Physician
i} Steph Curry MD Allopathic Physician
7 James Harden Master's Murse Practitioner
Submit
Figure 11: Successful CSV Upload
18
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4. After the analyst clicks on the Submit button a pop-up will display to confirm that the specific
rows selected are correct and that Tasks should be created for the awardee(s).

NHHSP Applicant Data Transfer

4 File name: good-data.csv successfully loaded.

rd

i

Submit

Please note: The following file type(s

Choose File | No file chosen

1

2

]

=~

WARNING

NHHSP Award Task Kick Off

Are you sure you want to create tasks for the 2 awardee(s) selected ?

TN

Johr
Jang
Larry
David
Hakeem
Steph

James

Wamer
James
Olajuwon
Curry

Harden

MD

MD

MD

MD

Master's

Allopathic Physician
Allopathic Physician
Allopathic Physician
Allopathic Physician

Murse Practitioner

. I

Figure 12: Applicant Data Transfer Submission

5. A banner message will be displayed to confirm successful submission and task creation for the
awardee(s) selected. Additionally, a flag will be displayed for each row. The analyst can click on
the View Details button next to the flag to review the reason for the flag, which in this case will
be to indicate that a Task now exists for the awardee and the analyst will now be unable to
select and re-submit that row to create another Task.

NHHSP Applicant Data Transfer

€9 2 of 2 task(s) created successfully.

Rank

1

2

Choose File | Mo file chosen

Please note: The following file type(s) are suitable for uplead: csv

Upload
First Name Last Name
John Smith
Jane Doe
Larry ‘Wamer
David James
Hakeem Olajuwon
Steph Curry

James Harden

Degree
MD

MD
MD
MD
MD
MD

Master's

Discipline
Allopathic Physician
Allopathic Physician

Allopathic Physician
Allopathic Physician
Allopathic Physician
Allopathic Physician

Murse Practitioner

Flagged
-« View Details
- View Details

Figure 13: CSV Data Successful Submission Banner
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6. If any of the rows selected for Task creation are unsuccessfully processed an error banner
message will be displayed for each individual awardee. The analyst will be able to re-select
those specific rows and re-submit.

NHHSP Applicant Data Transfer

‘ U Record : John Smith has failed to create a task.

‘ 9 Record : Jane Doe has failed to create a task.

‘ @ 2 record(s) failed to create a task

Please note: The following file type(s) are suitable for upload: csv

Choose File | No file chosen Upload
Rank First Name Last Name Degree Discipline Flagged
rd 1 John Smith MD Allopathic Physician
Ld 2 Jane Doe MD Allopathic Physician
3 Larry ‘Warmer MD Allopathic Physician
4 David James MD Allopathic Physician
5 Hakeem Olajuwon MD Allopathic Physician
i} Steph Curry MD Allopathic Physician
7 James Harden Masters Murse Practitioner
Submit

Figure 14: CSV Data Failed Submission Banner
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Section 9: Applicant Data Transfer - Validation Flags

Overview: The NHHSP Applicant Data Transfer page has a Flagged column designated to display
warnings and errors for each of the individual rows of data. For each flag the analyst can click on the
View Details button to view a pop-up with information about the reason for the flag. Additionally,
banner error messages can be displayed at the top of the page when an error occurs after the analyst
either uploads a CSV to the page or after a failed submission of selected data rows occurs. The analyst is
able to update the CSV data and upload the file again, or request that the Grantee, (POL) make the
correction and resubmit the file, so the analyst can repeat the import/upload process.

Business Rules: Analyst must have BMISS Intranet access and a NHHSP Reviewer role
CSV Validation Examples:

1. Anerror banner message will be displayed if any individual row does not included the required
number of comma separated values. In this case those specific rows will be identified by the row
number within the CSV file and will not be uploaded to the table on the page for possible
selection and submission.

NHHSP Applicant Data Transfer
‘ U Row number 1, has less data than expected. Please correct the row in the csv file and attempt to upload again.
Please note: The following file type(s) are suitable for upload: csv
Choose File | Mo file chosen Upload
| Rank First Name Last Name Degree Discipline Flagged
2 Tiger Woods MD Allopathic Physician v View Details
3 Justina Timberlake MD Allopathic Physician v View Details
4 Ariana Grande MD Allopathic Physician v View Details
5 Davis Love MD Allopathic Physician v View Details
Mike Tyson MD Allopathic Physician v View Details
7 Budd Kimberly MD Allopathic Physician v View Details
7 Steph Curry Master's Murse Practitioner v View Details
7 John Smith Master's Nurse Practitioner v View Details

Figure 15: CSV Validations Banner
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2. Aflag will be displayed for a row that already has a Task within the BMISS Task Manager with a
matching SSN value. The analyst will be unable to select and submit that row for re-submission.

NHHSP Applicant Da# Tranaéar

Flag Reasons | X

&9 2 of 2 task(s) create
Flag r n(s)

Flease note: The following 1 A review task already exists for this individual. Please review the existing task.

Choose File | No file ci

View Details

View Details

7 James Harden Masters MNurse Practitioner

Figure 16: Existing Task Flag

22
Property of HRSA | BHW



Bureau of Health Workforce
NHHSP Applicant Information Screen User Guide

3. Aflag will be displayed if a required field does not have data populated within the CSV file row.

NHHSP Applicant Data Transfer

‘ U Row number 1, has| Flag Reasons |i

Please note: The following { Flag reason(s]

Cohort is a required field.
Choose File | Mo file ch

2 View Details
3 View Details
4 View Details
5 View Details

View Details
7 View Details
7 Steph Curry Master's MNurse Practitioner ? View Details
7 John Smith Masters Nurse Practitioner ’ View Details

Figure 17: Required Field Missing Flag
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4. A warning flag will be displayed if the CSV has a row with a SSN that already exists within BMISS
for a participant. However, in this case this flag only acts as a warning and the analyst will still be
able to select that particular row for submission to create a Task.

NHHSP Applicant Data Transfer

U Row number 1, has| Flag Reasons

Please note: The following { Flag reason(s)

A Participant with the same SSN already exists in our system
Choose File | No file ch

View Details
3 View Details
4 View Details
5 Wiew Details

View Details
7 Wiew Details
7 Steph curry Masters Nurse Practitioner v View Details
7 John Smith Master's Nurse Practitioner ’ View Details

Figure 18: Duplicate SNN in BMISS Flag

NHHSP Applicant Data Transfer

‘ U Row number 1, has less data than expected. Please correct the row in the csv file and attempt to upload again.

Flease note: The following file type(s) are suitable for upload: cav

Choose File | No file chosen Upload
Rank First Name Discipline
2 Tiger Woods MD Allopathic Physician v View Details
L4 3 Justina Timberlake MD Allopathic Physician v View Details
4 Ariana Grande MD Allopathic Physician v View Details
5 Davis Love MD Allopathic Physician v View Details
Mike Tyson MD Allopathic Physician v View Details
7 Budd Kimberly MD Allopathic Physician v View Details
7 Steph Curry Master's Murze Practitioner v View Details
7 John Smith Master's Murse Practitioner v View Details

Submit _

Figure 19: Select Row with Duplicate SSN
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5. If two awardee rows within the same CSV have the same SSN an error flag will be displayed for
both and the analyst will not be able to select either until the CSV is updated and re-uploaded.

NHHSP Applicant Data Transfer

U Row number 1, has| Flag Reasons

Flag reason(s
Flease note: The following 1 g (s)

Duplicated Social Security Number within the csv file.
Choose File | No file ch

2 View Details
3 View Details
4 View Details
5 View Details

View Details
7 View Details
7 Steph Curry Master's Murse Pracitioner v View Details
7 John Smith Master's Murse Practitioner v View Details

Figure 20: Duplicate SSN in CSV Flag

6. An error flag will be displayed and the analyst will be unable to select the row if a continuation is
requested but the awardee within the CSV is not an existing participant within BMISS.

NHHSP Applicant Data Transfer

@ Row number 1, has| Flag Reasons ‘El

Please note: The following { Flag reason(s]

This individual is requesting a continuation. However the participant information cannot be
Choose File | Nofile cf| found.

2 View Details
3 View Details
4 View Details
5 View Details

View Details
7 View Details
7 Steph Curry Master's Nurse Practitioner v View Details
7 John Smith Masters Murse Practitioner ? View Details

Figure 21: Continuation Without Participant Flag
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Section 10: Applicant Data Transfer - Continuations

Overview: A ‘Continuations Years Requested’ field is included within each row of the CSV file. In the
event that the value for this field is 1, 2, or 3 (NULL(blank) is allowed, but 0 is not) and the awardee
requesting the continuation is an existing participant within BMISS, a flag will be displayed in the
Applicant Data Transfer page for that row. The analyst will not be able to submit that row to create a
Task for a New NHHSP Award. However, the View Details pop-up will contain a ‘Create Continuation’
link that will redirect the analyst to the continuation page in which the analyst can enter the required
data to submit the continuation request.

Business Rules: Analyst must have BMISS Intranet access and a NHHSP Reviewer role
Steps:

1. Analyst clicks on the ‘Create Continuation’ link within the View Details pop-up.

| | Rank First Name Last Name Degree Discipline Flagged
2 Tiger Woods MD Allopathic Physician v View Details
3 Flag Reasons View Details
& View Details
Flag reasoni(s)
5 View Details
This individual is requesting a continuation. Please use the Create Continuation page to
make the request View Details
7 View Details
7 View Details

BMISS 10.9.0-SNAPSHOT

Figure 22: Create Continuation Flag with Link
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2. Analyst submits all required documentation and data for the continuation request for the
existing BMISS participant.

Enter Continuation for Curry, Steph

¥ Supporting Documents

There are no uploaded documents

Please mote: The following file types are suitable for upload: pdf

Payment Authorization Worksheet *

Choose File | Mo file chosen Upload

Contract *

Choose File | Mo file chosen Upload
Posrard Letter *

Choose File | Mo file chosen Upload

¥ Award Information

‘fiears added to confract * Seleet ¥

Graduation Date * pei24rz0z2 [

Fiscal “fear and Funding Type * Select v
Descripfion  Amount FICA Employer Total

Amournt

Tuition =0.00 F0.00 F0.00
Stipend 0.00 $0.00 F0.00
ORC =000 30,00 50.00
Total $0.00 $0.00 $0.00

Figure 23: Continuation Redirect
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Section 11: Task Dashboard

Overview: The Task Dashboard will contain all of the individual NHHSP Tasks created from the Applicant
Data Transfer page. Analysts can Run each task to auto-populate the CSV data for that awardee in the
New NHHSP Award page.

Business Rules: Analyst must have BMISS Intranet access and a NHHSP Reviewer role
Steps:

1. Analyst navigates to Task Dashboard by clicking on the Task Dashboard link in the top right
corner of the BMISS Intranet portal.

2. Within Task Dashboard the analyst navigates to the NHHSP Tasks by clicking on Filter by Process
> Application Review > NHHSP Award Review > NHHSP Analyst Review.
3. Click on the Run button for the specific Task that needs to be run.

13-1821:02 | Environment: GAMMA | Node: APPITST | Build Date: 2019-03-1220:55 | DB Name: GAMMA_BMISS_CORE | DB Build Date: 03/13/2019
(@HRSA Health Resources & Services Administration

BM I SS Welcome hrsalasagib | Close

Sites & Schools

dataDc

Person Search User Administration

Participant Programs

Super Admin Ambassador

BHW Management Information System Solution

Figure 24: Task Dashboard Link

vemsstaskDashboard ]| Bnmiss
)
Assign Ownership ~ Set Priority  Label Tasks  Show All Tasks [Download Tasks, Process

» Custom Views
Results perpage: 25 v Totalresults: 4 Selected Tasks - 0

» Filter by Task Description Process Name & Task Name & Task Description & Owner & \
Application Review > NHHSP NHHSP Analyst  ID: 1; Rank: 1; Smith, John; Discipline: Allopathic Unassigned View Run
¥ Filter by Process Award Review Review Physician; Degree: MD
Application Review > NHHSP  NHHSP Analyst  1D: 2; Rank: 2; Doe, Jane; Discipline: Allopathic Unassigned View Run
Clear All | Select All .
Award Review Review Physician; Degree: MD
» Application Final Review = NCSP (1)
Application Review = NHHSP NHHSP Analyst  1D: 3; Rank: 1; fourty one, two; Discipline: Dietetics/Nutrition; Chandra View
» Application Review > NCLRP (1) Award Review Review Degree: Master's Malay
v Application Review = NHHSP Award Review (4) Application Review > NHHSP  NHHSP Analyst  ID: 4; Rank: 7; Curry, Steph; Discipline: Nurse Unassigned View Run
Clear All | Select All Award Review Review Practitioner; Degree: Master's

#| NHHSF Analyst Review (4) .

» Application Review > NHSC LRP (4)

Figure 25: NHHSP Applicant Review Tasks
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Section 12: New NHHSP Award - Upload Supporting Documents

Overview: Once the analyst has navigated to the New NHHSP Awards Screen, the first section at the top
of the page will request that the analyst upload the required supporting documents. These include the
following:

e Contract
e Award Letter
e W-4 Form

Business Rules:
e Analyst must have BMISS Intranet access and a NHHSP Reviewer role.
e The system shall only accept documents in PDF format.
e The system shall require all three documents to be uploaded in order for analyst to submit the
page for participant conversion.
e The system shall allow the analyst to view the uploaded documents by clicking on the document
name.

Steps:

Analyst selects Browse under the document they wish to upload.

Analyst selects the appropriate document.

Analyst clicks the Upload button

The system displays the date, time, document, and document type at the top of the page (see
screenshot on the next page).

Analyst repeats these steps for all three documents.

6. Analyst scrolls down to the next section: Personal Information.

PwnNPE

g

New NHHSP Awards

¥ Supporting Documents
Mo documents have been uploaded.

Please note: The following file types are suitable for upload: pdf

Contract

Choose File | Mo file chosen Upload
Award Letter

Choose File | Mo file chosen Upload
W-4 Form

Choose File | Mo file chosen Upload

Figure 26: New NHHSP Supporting Documents
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New NHHSP Awards

(_} Document successfully uploaded.

¥ Supporting Documents

0318/2019 09:07:40 PM pdf-sample.pdf{Contract)
03/18/2019 09:07:52 PM pdf-sample.pdf{iAward Letter)
03/18/2019 09:08:07 PM pdi-sample.pdf{W-4 Form)

Please note: The following file types are suitable for upload: pdf

Contract

Choose File | Mo file chosen Upload

Award Letter

Choose File | Mo file chosen Upload

W-4 Form

Choose File | Mo file chosen Upload

Figure 27: New NHHSP Supporting Documents Upload Confirmation
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Section 13: New NHHSP Award - Personal Information

Overview: After uploading the required supporting documents, the analyst will review data auto-
uploaded from the CSV and subsequent Task in the Personal Information section. For any missing data
the analyst can enter in the applicant’s personal information. This is divided into four sections of Full
Name, Phone and Email, Home Address, and Mailing Address. This information is needed for creating
the participant profile in BMISS.

Business Rules: System shall require the analyst to enter all required fields (fields with an *)
Steps:

1. Analyst reviews all data auto-uploaded from the CSV and selected Task
2. Analyst enters data manually for any missing required fields

¥ Personal Information

Full Name Home Address
First Mame * John Street Address 1~ 771 Lucky Dr
Last Name * Smith Street Address 2
Middle Initial H Country * United States A
Title Mr v City = Centreville
Suffix ar. v State or Territory * Virginia r
SEN* 031987893
Zip Code * 22052
D.OB* 0111511985 7]
Phone and Email Mailing Address
¥| Daytime Non-US Number Mailing Addrass is Same as Home Address
Daytime * 7039125
o 7039125852 Street Address 17 838 happy dr
Home Mon-US Number Street Address 2 suite 1
Home * E71) 345-7777
(571) Couniry * United States v
Mobile Non-US Number ) -
City springfield
Mobile (571) 345-7777
State or Termitory * Virginia v
Email
Zip Code = 20120
Personal personal@email.com
Work work@email.com

Figure 28: Personal Information
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Section 14: New NHHSP Award - School Information

Overview: The School Information section includes a read only University Details from CSV section of
data that can be used by the analyst to manually search and add a School ID # within the School Details
section. The Degree Details section has fields that can be auto-uploaded from the CSV or can be
manually updated as well by the analyst. The School ID, Discipline, Degree, and Cohort fields are
required to do a verification that a DCW exists within BMISS in order to process a NHHSP award
calculation.

Business Rules: System shall require the analyst to enter all required fields (fields with an *)
Steps:

1. Analyst reviews the read only data in the University Details from CSV section and can use this to
search BMISS for the associated School ID #.

¥ School Information

University Details from CSV

University Name University of Virginia
Street Address 1 8838 Memory Ln
Street Address 2 Suite 200

Country United States

City Charlottesville

State or Territory Virginia

Zip Code 22802

School Search

School Details Degree Details
School ID # * Cohort * 2019
Update School Year In School * 2 v

School ID: Graduation Date * 052412022 [

MName:

State: .
Discipline * Murse Practitioner ¥
Degree * Master's ¥

Figure 29: School Information
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2. The analyst can click on the School Search link to open a separate BMISS tab to perform a
search.

School Search

School Details

Degree Details

School ID#* Cohort * 2019
Update School Year In School * 2 v
School ID: Graduation Date * 05/24/2022 [T
Name:
State: o
Discipline * Murze Practitioner v
Degree * Master's v

Figure 30: School Search Link

3. Enter the corresponding school, program, discipline, and degree details to perform a school
search. Copy the School ID to be entered in the previous page.

Search Schools

School Search

School Name University of Virginia

School ID

State or Territory Select v

Has Degrees for Year Select v

Program NHHSP v

Discipline Nurse Practitioner ¥
Degree Select v

Search  Clear

Search Results Add New School

School ID School Name Most Recent Accredidation State

Virginia Commonwealth University - School of Nursing 2019 \irginia

University of Virginia - School of Nursing 2019 Virginia
West Virginia University - School of Nursing 2019 West Virginia
3256 West Virginia University Institute of Technology 2019 West Virginia

Figure 31: School ID

4. Enter the School ID # and click Update School. The School ID, Name, and State fields should be
displayed, along with a banner message at the top of the page.
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School Search

School Details
School ID#* 622

Update Schoal ’

School 1D: G22
Mame: University of Virginia - School of Nursing

State: Virginia

Figure 32: Update School ID

New NHHSP Awards

(_} School has been updated succassfully to 'University of Virginia - School of Nursing'

¥ Supporting Documents

031872019 09:44:29 PM pdf-sample.pdf{Contract)
03M18/2019 09:44:41 PM pdf-sample.pdf{Award Letter)
031872019 09:44:56 PM pdf-sample.pdf{W-4 Form)

Figure 33: School ID Update Confirmation
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Section 15: New NHHSP Award - Financial Information

Overview: The CSV file does not include any data fields for the Financial Information section and will
require that the analyst manually input this section data.

Business Rules: System shall require the analyst to enter all required fields (fields with an *).
Steps:

1. Analyst enters data manually for the Financial Information section

¥ Financial Information

Banking Information W-4 Information

EBank Mame * Bank of America Allowance Quantity * 1

Account Type * Checking v Withholding Amount * =0.00

Routing Number * 011103093 Tax Exempt

Account Number * 234564433 Marriage Siatus * Single Person v

Figure 34: Financial Information
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Section 16: New NHHSP Award - Award Information

Overview: The Award Information section is intended to determine the award breakdown and total for
the participant. The Requested Funding Start Date, Requested Funding End Date, and In State / Out of
State selection can be auto-populated from the CSV data or can be manually updated by the analyst.
Additionally, the analyst will need to select a Fiscal Year and Funding Type to determine the source of
funding, and the specific years to fund the award. The system will validate to confirm that an existing
approved DCW is available in BMISS that matches the School/Discipline/Degree/Cohort combination
selected previously, and will then auto-calculate the award. The award can by dynamically updated if
the analyst changes the values for In State / Out of State selection or the specific years funded.

Business Rules:

e System shall require the analyst to enter all required fields (fields with an *)

e Fiscal Year and Funding Type must have sufficient budget for the award

e The Requested Funding Start Date must start on or after 07/01/YYYY

e The Requested Funding End Date must be after the Requested Funding Start Date and must end
on 06/30/YYYY

e The Years with Funding Requested table will start with the selected Year in School value and will
have a maximum of four (4) years total. This table will have four rows for selection but will
disable any rows beyond four years

e The Years with Funding Requested selected must begin with the first year available and must be
consecutive

e The Verified Start Date will default to 07/01/YYYY

e The Verified End Date will default to 06/30/YYYY

Steps:

1. Analyst reviews or selects values for all required fields:
e Fiscal Year and Funding Type
e Requested Funding Start Date
e Requested Funding End Date
e In State / Out of State

¥ Award Information

Rank 2

Fiscal Year and Funding Type * 2019 NHHSP v
2019 NHHSP Available Balance: $792,126.31
Funding Years Information
YYear in school
Regquested funding Start Date * 07/01/2019
Reguested funding End Date * 0613012021 [

In State / Out of State * @® In State Out of State

Figure 35: Award Information
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2. Analyst selects the specific years to provide funding from the Years with Funding Requested
table

Years with Funding Requested

Year Verified Start Date Verified End Date Year In School Provide Funding

2019 - 2020 07/01/2019 [ 06/30/2020 [ 2 #| Provide Funding for School Year 2018 - 2020
2020 - 2021 07/01/2020 [ 06/30/2021 [ 3 Provide Funding for School Year 2020 - 2021
2021-2022 07/01/2021 [ 06/30/2022 [T 4 Provide Funding for School Year 2021 - 2022
2022 - 2023 07/01/2022 [T5 D6/30/2023 [ Provide Funding for School Year 2022 - 2023

Figure 36: Years with Funding Requested Table

3. Inthe eventin which the DCW validation errors are present the analyst must verify that an
approved DCW exists with the correct School / Discipline / Degree combination

Award Breakdown

Tuition 50.00 DCW not found based on School 1D, Discipline, and Degres
selected.

Stipend 50.00

ORCs 50.00

Unable to calculate award amount.
FICA Employer Tax $0.00

Total Award Amount  £0.00

Preview Paw

Figure 37: DCW Validations

4. The system will auto-calculate the Award Breakdown and enable the Preview PAW button.

Award Breakdown

Tuifion $21,000.00
Stipend $16,356.00
CRCs $1,000.00

FICA Employer Tax $2934.23

Total Award Amount  $41,290.23

Preview Paw

Figure 38: Award Breakdown
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Section 17: New NHHSP Award - Preview PAW

Overview: After the auto-generated Award calculations are complete the system will enable a Preview
PAW button below the Award Breakdown. The analyst will be able to click on that button and download
an auto-generated PDF version of the NHHSP PAW in order to review the full break down of the award
and the DCW values that contributed to the Tuition, Stipend, and ORCs. Additionally, the PAW will
reflect the number of years of funding requested and will have a separate column of award data for

each year requested.

Business Rules: The Preview PAW functionality will be enabled once the Award calculation criteria are

complete.

Steps:

1. Ensure that all criteria for the Award calculations are complete and click on the enabled Preview
PAW button.

Years with Funding Requested

Verified Start Date Verified End Date Year In School Provide Funding

2019 - 2020 #!| Provide Funding for School Year 2019 - 2020

06/30/2020 [ 2

oviot201e [

2020 - 2021 07/01/2020 [ 06/30/2021 [ 3 | Provide Funding for School Year 2020 - 2021
2021 - 2022 07/01/2021 [ 061302022 [ 4 Provide Funding for School Year 2021 - 2022
2022 - 2023 07/01/2022 (5 06/30/2023 [ Provide Funding for School Year 2022 - 2023

Award Breakdown
542.315.00

$32.940.98

$2,000.00

ICA Employer Tax $5,910.08

otal Award Amount  $83,166.06

Preview Paw ”

Figure 39: Preview PAW Button
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2. The analyst will be able to view the auto-generated NHHSP PAW in a separate browser tab or

PDF.

Native Hawaiian Health Scholarship Program- Participant Award Worksheet- PAW
Scholar Name: Mr. John h Smith, Sr. EIN: 7896 Award Type: NEW
Home Address: 888 happy dr Year: 2019
suite 1
springhield, VA United States

School/University Virginia Commonwealth University - School

of Nursing
Discipline Nurse Practitioner Degree: Master's
Year in School 2 Graduation Date: May 24, 2022
Program Start Date Jul 1, 2019 Contract Start Date: Jul 1, 2019
Program End Date Jun 30, 2019 Contract End Date: Jun 30, 2021
Funding Yrs Requested 2 Resident/Non-Resident: Resident
Total Tuttion & Fees: S42 315.00
Total Stipend & ORC: 53494098
Total FICA Employer (7.65%): £5,910.08
Total Scholarship Award: 583,166.06
[ Analysis of Award Amount
School Year 2019 - 2020 2020 - 2021
Tuition & Fees £21,000.00 §21,315.00
Stipend 516,356.00 516,584 98
ORCs $1,000.00 $1,000.00

Totals: 53K,356.00 538,899.98
[ Tuition & Fees
Tuition: Resident £20,000.00 £20,000.00
Academic Support Services $1,000.00 $1.000.00
Administrative Fees $0.00 S0.00
Background Check 50.00 50.00
Campus Life Fee S$0.00 S0.00
Capstone Course (1f required) $0.00 S0.00

Figure 40: PAW Preview
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Section 18: New NHHSP Award - Save and Close

Overview: The system will allow the analyst to save the New NHHSP Award page prior to submission
without having all of the required fields completed. The analyst will then be able to return to complete
and submit at a later date by navigating to the Task Dashboard and selecting Run for the given Task.

Business Rules:

e The Save functionality is only available for Tasks within Task Dashboard and will not be available
if an analyst creates a New NHHSP Award manually (Programs > NHHSP > New Award)

e Data must be entered into one or more of the fields within the New NHHSP Award page to
enable Save

Steps:

1. Analyst clicks on the Save and Close button

¥ Comments

There are no existing comments.

New Comments *

Submit | Save and Close Cancel Award

Figure 41: Save and Close

2. The analyst is redirected to Task Dashboard. The analyst can navigate back to Task Dashboard at
any time and click on the Run button to continue making updates and submit the Task

vemiss taskDashboard BMISS

Assign Ownership  Set Priority  Label Tasks  Show All Tasks | Download Tasks Process

Results perpage: 25 ¥ Total results: 4 Selected Tasks : 0

Process Name & Task Name £ Task Description § Owner 2

Application Review > NHHSP NHHSP Analyst  1D: 2; Rank: 2; Doe, Jane; Discipline: Allopathic Unassigned View Run
Award Review Review Physician; Degree: MD

Application Review = NHHSP NHHSP Analyst D: 3; Rank: 1; fourty one, two; Discipline: Dietetics/Nutrition; Chandra View

Award Review Review Degree: Master's Malay

Application Review = NHHSP NHHSP Analyst D: 1; Rank: 1; Smith, John; Discipline: Allopathic Physician;  Asad Sagib View Run
Award Review Review Degree: MD

Application Review = NHHSP NHHSP Analyst D: 5; Rank: 7, Smith, John; Discipline: Nurse Practitioner, Asad Sagib View Run
Award Review Review Degree: Master's a

Figure 42: Run Task

40
Property of HRSA | BHW



Bureau of Health Workforce
NHHSP Applicant Information Screen User Guide

Section 19: New NHHSP Award - Cancel Award Task

Overview: Analysts are able to cancel NHHSP Award Tasks and remove them from the Task Dashboard.
Business Rules: Analysts can only cancel existing Tasks
Steps:

1. Analyst clicks on the Cancel Award button on the New NHHSP Award page

¥ Comments

There are no existing comments.

New Comments *

Submit = Save and Close \Cancel Award

Figure 43: Cancel Award

2. A confirmation pop-up is displayed and the analyst can click Yes to cancel the Award Task and
remove it from Task Dashboard

¥ Comments

There are no existing comments.

Cancel NHHSP Award Task. A comment is required for cancelling the award.
New Comments *

WARNING

Are you sure you want to cancel this award?

Yes No

Submit  Save and Close Cancel Award

Figure 44: Cancel Award Task Confirmation
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Section 20: New NHHSP Award - Submit Applicant Data

Overview: When the analyst is ready to submit the New NHHSP Award data to create the Participant
Profile and Financial Obligation they will be required to enter in comments, select Submit, and confirm.

Business Rules:

Analyst must enter comments to Submit.
After the analyst selects Submit, the system shall ask the analyst to Confirm Award.
When confirming, the system shall display all information as “Read Only.”

el e

When confirming after selecting Submit, the analyst can select to go back and edit any
information. The analyst will need to then Submit again.
5. Analyst must select Confirm Award in order for the applicant information to be saved in BMISS.

Steps:

1. Analyst enters in comments
Analyst selects Submit

¥ Comments

There are no existing comments.

New Comments *
Final

Submit  Save and Close Cancel Award

Figure 45: Submit Button
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3. System will ask the analyst to confirm the information entered on the page

New NHHSP Awards

‘ L) Please verify the information below and press confirm

¥ Supporting Documents

03/18/2019 09:44:29 PM pdf-sample.pdfiContract)
03/18/2019 09:44:41 PM pdf-sample.pdfiAward Letter)
03/18/2019 09:44:56 PM pdf-sample.pdfiw-4 Form)

¥ Personal Information

Full Name Home Address

First Name * John Street Address 1 771 lucky dr

Figure 46: Verify NHHSP Award Data

4. Analyst reviews the information and selects Confirm
5. Analyst is directed to the Participant Profile page in BMISS

¥ Comments

There are no existing comments.

Mew Comments *
Final

Confirm Back

Figure 47: Confirm NHHSP Award Data
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Section 21: New NHHSP Award - Manual Input of Applicant Data

Overview: Analysts are also able to manually enter and submit New NHHSP Award data in order to
create a Participant Profile and Obligation without uploading a CSV in the NHHSP Applicant Data

Transfer page.

Business Rules:

Steps:

BHW Management Information yceene

Welcome to BMISS! NHSC LRP

BMISS is the way we conduct business with our p
BHW employees and it will only improve and adve njcsp ide y

feedback on BMISS to your BMISS Expert or your

To ensure BMISS works for everyone, remember s messem—sm

System shall require the analyst to enter all required fields (fields with an *)
The analyst will not be able to Save data through this process since it is not a Task within Task

Dashboard

Analyst navigates to the New NHHSP Award screen (Programs > NHHSP > New Award)
Analyst manually enters all required fields and uploads documents

Analyst submits data for participant conversion

@HRSA Health Resources & Services Administration

Person Search Participant Sites & Schools u

Super Admin Ambassador FLRP

NCLRP

NHHSP Batch History

Budget

NHSC sp Create Batch for al

525 LRP Create Tuition Payment
File

Applicant Data Transfer
Be clear and complete in your summaries and comments. You me icipar]

that contacted BHW previously. You know what level of detail you need to do that, =0 be sure when
putting comments and summaries into BMISS you offer the same level of detail you would need if
responding to a participant that has inguired before.

Figure 48: New NHHSP Award Navigation for Manual Input

44
Property of HRSA | BHW



Bureau of Health Workforce
NHHSP Applicant Information Screen User Guide

Section 22: NHHSP Participant Profile and Obligation

Overview: Once all NHHSP Applicant information has been submitted and confirmed, a participant
profile will automatically be created for the person based on the information that was entered. The
analyst will be automatically taken to the person’s participant profile page upon submission of the
applicant information. The applicant will not have been awarded and converted to participant at this
point, although their participant profile will have been created. The applicant will be ready for batching
after submission of applicant information.

Business Rules:

e Basic participant information will be captured at the top of the page within the header section
e System will pre-populate the person’s information on their participant profile page based on the
information that was entered on the New NHHSP Award screen

Steps:

1. The analyst will be automatically redirected to the Participant Profile after submitting the New
NHHSP Award data. Additionally the analyst can navigate to this page through a Participant
Search (Participant > Participant Search)

— @MRS A\ Health Resources & Services Administration
BM I S S Welcome hrsa\asagib | Closq

Person Search Participant Programs Sites & Schools User Administration Reports
Super Admin Ambassador
Smith, John HPSAs
ID Number: 1119552087 Phone: 5713457777 Graduation Date:  05/24/2022
Program: MHHSP Address: 771 lucky dr Budget Type: MHHSP
o " suite 2 . §
Discipline: Murse Practitioner centreville, VA 22052 United Service: 2YT Full Time 2019
Specialty: States Estimated End Date:
Status: PDF Profile: view =T
R Personal Information
Overview

— ‘ (2 Participant has been successfully created and award has been sent to the obligation pool.
nquiries

Personal Information m Contact ||| Other

Education Information

* Required Field
Program Information

Name
Professional Information

Last® Smith
Financial Information X

First * John

Figure 49: NHHSP Participant Profile
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2. The Financial Information section will display the Contract, Award Letter, and PAW documents
which can be viewed and downloaded

Participant Profile Financial Information

Overview

Award Documents Tax Information Payment Schedule Banking Information Award History Debt Estimator
Inquiries
Personal Information ¥ Fiscal Year 2019 Award Documents

Education Information

Award Type: Contract Type: Contract Length:
Program Information New Eull Time 2
Professional Information

Documents
Financial Information
Verification Information Contract

» Current Version: pdf-sample.pdf (3/18/19 9:44:29 PM): hrsa_asaqib

Compliance
Service Requests Award Letter

s Current Version: pdf-sample.pdf (3/18/19 9:44:41 PM): hrsa_asaqib

Payment Authorization Worksheet
» Current Version: Payment Authorization Worksheet_5.pdf (311819 10:46:11 PM): hrsa_asaqgib

Figure 50: Financial Information Documents

3. The analyst will be able to navigate to all of the sections within the Participant Profile to view
and edit data fields

Participant Profile
Owerview
Inquiries
Personal Information
Education Information
Program Information
Professional Information
Financial Information
Verification Information
Compliance

Service Requests

Figure 51: Participant Profile Section Navigation
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Section 23: Resolving Issues
Please follow the instructions to resolve any problems a NHHSP Analyst might have:

For Technical Issues:

When a technical issue is encountered, e.g. Analyst cannot upload the supporting documents, the issue
should be logged in JIRA with a detailed description of the problem. At this point, the BMISS Production
Support Team would define and resolve the issue as well as notify the analyst of the resolution.

Logging Issues:

o  When logging tickets into JIRA:
o Log tickets as a Defect within the BMISS DBO Partners (BDP) project
o Attach a screenshot to the ticket (if applicable)
o Include the following details in the Description section:

e The page that the issue was found on = New NHHSP Award Screen

e Applicant information: BMISS unique ID, email, phone number, and Full name

e The Web Browser the analyst was using

o The frequency of the issue
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